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Thank you very much for purchasing Fuji’s multi-loop module-type temperature controller. Please read this instruction manual 
carefully before using the instrument. Make sure that this instruction manual will be handed over to the fi nal user of this 
software (PUM parameter loader).

Note

The contents of this manual are subject to change without notice.
This manual is complied with possible care for the purpose of accuracy, however, Fuji Electric shall not be held liable for any 
damages, including indirect damage, caused by typographical errors, absence of information or use of information in this 
manual.
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1  About the copyright of this software
The copyright of this software (PUM parameter loader) belongs to Fuji Electric Co., Ltd. Reproduction of any form or distribution 
of this software without permission is prohibited.

2 Outline
This software (PUM parameter loader) is an auxiliary tool for setting parameters and tuning the module-type temperature 
controller. The setting conditions can be edited and saved with this software. By setting, editing, and saving parameters on your 
PC, the setting can be copied for multiple module-type temperature controllers. The PV, SV, and MV trend can also be displayed 
as an auxiliary tool for tuning the module-type temperature controllers.
Unless otherwise specifi ed, the parameter loader for module-type temperature controllers (PUM) is referred to as “PUM 
parameter loader” or “this software” in this manual.

3 Operating environment
OS : Windows XP (English version)
RAM : 128M bytes or more recommended
Free hard disk space : 500M bytes or more recommended
Display resolution : 1024 × 768 pixels or higher
Excel : Microsoft ® Offi ce Excel
Reader : Adobe Reader

Note

  Windows® is a registered trademark of Microsoft Corporation.
  Excel® is a registered trademark of Microsoft Corporation.
  Adobe® and Reader® are registered trademarks of Adobe Systems Incorporated.
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4 Installing/uninstalling the software
Install the PUM parameter loader in your PC before use. Uninstall the software if it is no longer required.

Installation

Install the PUM parameter loader as follows.

1  Open the “PUM loader” folder that has been downloaded, and then double-click “setup.exe.”
 Refer to the Table of corresponding revision No. to a PUM parameter loader (P.62) for the software revision No.
2  Click [Next] to continue.

Click.

■To cancel the installation
  Click [Cancel].

 



INP-TN5A0201d-E 5

3  Enter “User Name” and “Company Name”, then click [Next].

Click.

■To return to the previous screen
  Click [<Back].

■To cancel the installation
  Click [Cancel].

Note

You can not go to next procedure unless entry user’s information.

4  Select set-up type, then click [Next]. 

– When you selected set-up type, [all (C)] → go to 7 .
– When you selected set-up type, [Custom (S)] → go to 5 .

■To return to the previous screen
  Click [<Back].

■To cancel the installation
  Click [Cancel].

Click.
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5  Select the folder you want to install in, then click [Next].

(2) Click.

■To return to the previous screen
  Click [<Back].

■To cancel the installation
  Click [Cancel].

6  Select the functions you want to install, then click [Next (N)>].

(2) Click.

■To return to the previous screen
  Click [<Back].

■To cancel the installation
  Click [Cancel].

(1) You must check the box.

(1) Although you can change the folder you want to 
install in by clicking [Change], we recommended 
to install as the initial setting is.
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7  Click  [Install].

Click.

■To return to the previous screen
  Click [<Back].

■To cancel the installation
  Click [Cancel].

8  Installation begins. 

■To cancel the installation
  Click [Cancel].
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9  Click [Finish] to exit. 

Uninstallation

Select “Setting (S)” → “Control panel (C)” → “Program Add/Delete” from the start menu to uninstall the software.

Click.
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5 Connecting your PC to the module-type temperature controller
Connect your PC to the module-type temperature controller using the RS-232C interface.

Note

  Make the setting, being careful not to make the station Nos. of the module-type temperature controllers duplicate. The station 
number of the control module (PUMA/B) or the analog module is the station number confi guration switch +1, and that of the event 
module (PUME) is the station number confi guration switch +17.

  Connection via RS-485 communication is not supported.  
  When operating the parameters of the enhanced communication module, connect the loader connecting cable to the loader 
communication port of the enhanced communication module.

 

Connection with RS-232C

Provide the optionally available cable for loader connection (RS-232C, Type: PUMZ *L01). Connect the RS-232C port (D-sub 9 
pin) and the loader communication port on the front face of the module-type temperature controller with the loader connecting 
cable.

[When connecting the PUM parameter loader to a control module, an event module, and an 
analog module]
<Connecting a single unit>

D-Sub 9 pin

PC

Master

Loader connecting cable
(RS-232C)
PUMZ*L01

RS-232C

Station number 
configuration switch
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<Connecting multiple units>
(1) Adjust the station number confi guration switch to “0” position. 

* The station number confi guration switch can be adjusted a 
control/event/analog module in hexadecimal digits from 0 
to F.

(2) Connect one unit only fi rst, and then select on the tree structure in the left fi eld of the "PUM parameters Support" screen (on 
P. 23) "Control module →1; Parameter → 6; Communication →6; Master/Slave" setting connected module to "Master". (See 
"Parameter setting" on P. 23 for details of the setting.)

* The multiple module-type temperature controller set in (2) above functions as the master..
(3) Connect multiple module-type temperature controllers to the one set as the master clockwise.
 

Note

Be sure to turn off the power of the module-type temperature controllers before making connections.

(4) Set the station number confi guration switches of the connected module-type temperature controllers as 1, 2, ……, F (station 
Nos.: 2, 3, ……, 16) consecutively from left.

* Control/Analog module : Station number confi guration switch set value + 1 = Station No.
Event module : Station number confi guration switch set value + 17 = Station No.

Note

Set the station number of the control/analog module in the range of “1” to “16” without number duplication.

(5) Following the procedure “Parameter setting” (on P.23), check that “Control module → 1; Parameter → 6; Communication → 
6; Master/Slave setting connected module is set to “Slave” except for the fi rst one, which is set to “Master.”

Note

When all the settings are completed, turn on the power again.

Station number 
configuration switch
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Completed connections

St. No.
Set value of the St. No. configuration switch

ST1
0

ST2
1

ST16
F

Master Slave Slave

ST17
0

Slave

ST32
F

Slave

Control module + Analog I/O module
(Total max. 16 units)

Event I/O module
(Total max. 16 units)

LOADER

PUM-APWR

COM

OUT1

OUT2

OUT3

OUT4

STATION
4321

0
F E D C BA9

8
765

LOADER

PUM-EPWR

COM

STATION
4321

0
F E D C BA9

8
765

STATION
4321

0
F E D C BA9

8
765

LOADER

PUM-EPWR

COM

[When connecting the PUM parameter loader to the enhanced communication module]

LOADER

PUM-C

STATION
432

1
0

F E D C BA9
8

765

PWR

BUS

RX1

TX1

RX2

TX2

D-sub 9 pins

PC

Master

Loader connecting cable
(RS-232C)
PUMZ*L01

RS-232C

St. No. configuration switch

Note

When you operate parameters of an enhanced communication module, the loader connecting cable should be connected to 
the loader communication port on the enhanced communication module directly.

*Figure above shows the case that Mitsubishi's programless communication (PUMCM) is used
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Note

When all the settings are completed, turn the power on again.

<Completed connections>

St. No.
Set value of the St. No.

 configuration switch

ST128
0 to 7 (Mitsubishi programless 
           communication)
0 to 99 (Profibus communication)

ST1
0

ST16
F

Master

ST2
1

Slave Slave

ST17
0

Slave

ST32
F

Slave

Enhanced 
communication module

Control module + Analog I/O module
(Total max. 16 units)

Event I/O module
(Total max. 16 units)

LOADER

PUM-APWR

COM

OUT1

OUT2

OUT3

OUT4

STATION
4321

0
F E D C BA9

8
765

LOADER

PUM-APWR

COM

OUT1

OUT2

OUT3

OUT4

STATION
4321

0
F E D C BA9

8
765

STATION
4321

0
F E D C BA9

8
765

PWR

BUS

RX1

TX1

RX2

TX2

LOADER

PUM-C
LOADER

PUM-APWR

COM

OUT1

OUT2

OUT3

OUT4

STATION
4321

0
F E D C BA9

8
765

LOADER

PUM-EPWR

COM

STATION
4321

0
F E D C BA9

8
765

STATION
4321

0
F E D C BA9

8
765

LOADER

PUM-EPWR

COM

Note

Always place the enhanced communication module on the left of the control module set as the master.

*Figure above shows the case that Mitsubishi's programless communication (PUMCM) is used
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6 Starting the PUM parameter loader
Select “PUM loader” on the start menu, and the following “ Module type selection” screen appears.

1  Select the type of the module-type temperature controller you want to start on the “module type selection” screen, then click 

[OK].

(2) Click.

(1) Select the type of the module-type temperature 
controller you want to start.

2  “Startup mode” screen appears.

The display screen of the control/ event/ analog module on start-up

“Selecting mode/File selection startup mode” 
(p.15)

“Selecting mode/File selection startup mode” 
(p.17)

* Only the control/event/analog module is 
selectable of “Startup mode/Module data 
reception launch mode”
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The display screen of the enhanced communication module on start-up

“Selecting mode/File selection startup mode” 
(p.15)

“Selecting mode/Module data reception 
launch mode” (p.17)

Note

If you select the module type other than the module-type temperature controller selected on the “Module type selection” 
screen, communication fault on start-up occurs. Select the proper module type.
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Selecting mode/File selection startup mode

Read the parameter setting fi le stored previously as follows.

1  Select “File selection startup mode” on the “Startup mode” screen, and then click [OK].

The display screen of the control/event/analog module on start-up

(2) Click

(1) Click.

The display screen of the enhanced communication module on start-up

(2) Click

(1) Click.
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2  On the “File selection startup mode” screen, select the fi le or the parameter setting stored previously, and then click [Open].

(2) Click.

(1) Select

The “PUM loader-PUM parameters Support” screen appears (p.23).
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Selecting mode/module data reception launch mode

Read the parameter setting of the connected module-type temperature controllers as follows.

1  On the “Startup mode” screen, select “Module data reception launch mode” and then click [OK].

The display screen of the control/event/analog module on start-up

(2) Click.

(1) Click.

The display screen of the enhanced communication module on start-up

(2) Click.

(1) Click.
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2  The “PUM loader-PUM Parameters Support” screen appears (p.23).

Check the connected module-type temperature controllers automatically, and then read the set value out.

■To cancel reading
  Press the [Esc] key on the keyboard to cancel reading.

Note

  Approximately 20 seconds are required to read the parameter settings per module-type temperature controller. Do not 
perform other communication operations while the settings are read.

  Do not turn off the power of the module-type temperature controller while the settings are read.
  Do not pull out the loader connection cable while the settings are read.
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Reading the setting by selecting the Station No. of the module-type temperature 
controllers connected

This method is not available when selected the "Enhanced comm module [Mitsubishi's programless comm]", "Enhanced comm 
module [Profi bus comm]" on the “module type selection”.

1  Select “Module data reception launch mode” on the “Startup mode” screen, check “Module connection designation,” and 
click [OK].

(3) Click.

(1) Click.

(2) Check.

2  Check the St No. of the module-type temperature controller to be read on the “Station defi nition” screen, and then click [OK].

(1) Check. 
*1

(2) Click.

Note

Do not check the ST No. of the controller that is not connected.  Otherwise a communication error occurs.  The “communication 
error” message does not appear in this case.  (The reading from the module-type temperature controller connected is performed 
normally.)

*1: Select from the Station Numbers of "Control 
module" with Analog module.
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3  The “PUM loader – PUM Parameters Support” screen appears (P.23).

Read the parameter set value out from the module-type temperature controller of the St. No. that was checked in the box.
■To cancel reading
  Press the [Esc] key on the keyboard to cancel reading.

Note

  Approximately 20 seconds are required to read the parameter settings per module-type temperature controller. Do not perform 
other communication operations while the settings are read.

  “Offl ine: STNo.” is displayed in (1) and a bar indicating progress status is displayed in (2) while communication is carried out. 
“Offl ine: ” is displayed in (1) and nothing is displayed in (2) when communication is not carried out.

(2)(1)
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7 Initial setting
Perform initial setting of the PUM parameter loader as follows.

1  On the “PUM loader – PUM Parameters Support” screen, select “Initial setting” on the “File” menu. 

Click.

2  Set required items on the “Initial setting” screen, and then click [OK].

Click.

Select COM port.

Baud rate: 19200 (Fixed)

Data length: 8 (Fixed)

Parity: None (Fixed)

Stop bit: 1 (Fixed)

Connection: Control/communication (Fixed)
* Note 1

“Online function” (P.35)

Language: English (Fixed)

* Note 1: Connection method is not selectable when started up with the enhanced communication module.
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Note

The “Online/Offl ine” setting can be made only when startup is performed by selecting “Module connection designation” on the “Startup 
mode” screen.

The setting is always "Offl ine" on start-up.
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8 Parameter setting
In parameter setting, frequently-used parameters can be registered in Favorite, parameter settings can be changed, state of the 
connected module-type temperature controllers can be checked, trend can be displayed, and parameters can be copied.

“PUM loader – PUM Parameters Support” screen

On the “PUM loader – PUM Parameter Support” screen, parameter tree is displayed on the left, and setting can be made on the 
right fi eld.

[The display screen of the control/event/analog module on start-up]

Parameters are displayed.

Parameter tree is displayed. “Station No. – (Channel)”

Set values are displayed.
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[The display screen of the enhanced comm module [Mitsubishi's programless comm] 
on start-up]

Parameters are displayed.

Parameter tree is displayed.

Set values are displayed.
* Blank cell cannot be set.
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[The display screen of the enhanced comm module [Profibus comm] on start-up]

Parameters are displayed.

Parameter tree is displayed.

Set values are displayed.
* Blank cell cannot be set.
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Setting parameters

This section describes how to set parameters.

1  On the “PUM loader – PUMP Parameters Support” screen (on P.23), select the parameter group to be changed, and on the 

setting screen on the right, double-click the setting to be changed.

(1) Select the parameter group from the Parameter tree. (2) Double-click the setting to be changed.

2  Set a desired value on the “Please set the value” window, and then click [OK].

(2) Click.

Displays the parameter setting range
(1) Enter or select desired setting.

■To transmit the changed setting to the module-type temperature controller
  See Downloading (transmission from PC to PUM) (on P.52).
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Note

  When entering or selecting values from the pull-down menu, be careful not to select or enter those other than the set values 
(such as character strings) or “No function” display other than “0: No function.”

  Do not set the same value for “PV input scale lower” and “PV input scale Upper”
  The term "Logic output" used for event module parameters represents event output.
  When PV input type, PV input scale upper/lower limit, or decimal point position is changed, review all the industrial value 
parameters, which are displayed in %FS unit.

  When the parameter display is scrolled, parameters of a different group may be displayed. In this case, display a different 
group fi rst, and then display the desired group.

  The setting range display may exceed the value that can actually be set.
  Do not directly enter numeric values for the parameters for which pull-down menu is displayed. (The values that do not fall 
within the setting range may be set.)

  Some values banned setting are included in the setting range displaied in the enhanced communication module. Refer to 
the detailed parameter manual in the relevant parameters (p.33) about the values banned setting. 

  Press the [Enter] key on the keyboard while the setting to be changed is selected, and the setting entry or selection screen 
is displayed. If the [F5] key on the keyboard is pressed, the focus is switched between the parameter tree screen (on the left 
side) and the setting screen (on the right side).

  The settings that have been changed are displayed in red. The red display is kept valid until they are uploaded.
  <SV limit value>

The SV value is limited and automatically changed according to the change of SV limit.
  <Automatic industrial value conversion>

The parameters displayed in industrial values are automatically converted into values within the setting range in 
accordance with the change of PV input type, PV scale, and decimal point position.

  <Automatic alarm setting conversion>
The alarm settings are automatically converted into values within the setting range in accordance with the DO output 
event type setting.

Point
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Favorite

Frequently-used parameters can be set in “Favorite” in the parameter tree screen on the left side.  Up to 200 parameters per 
module can be registered.

Displays parameters set in “Favorite.”
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Registering in “Favorite”
1  On the parameter tree of the “PUM loader – PUM Parameters Support” screen (on P.23), right-click the parameter you want 

to register in “Favorite” and then click “Favorite Add/Delete.”

(2) Click.

Press the [F2] key on the keyboard while a parameter is selected on the parameter tree on the left side, and the parameter 
can be registered in Favorite.

Point

(1) Right-click.
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Deleting the registration in “Favorite”
1  Right-click a parameter within the “Favorite” tree on the “PUM loader – PUM Parameters Support” screen (on P.23), and 

then click “Favorite Add/Delete.”

(2) Click.

(1) Right-click.

Press the [F2] key on the keyboard while a parameter is selected on the parameter tree screen on the left side, and the 
parameter can be deleted from Favorite.

Point
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Switching between display ON and OFF

Parameter display on the setting screen on the right side can be changed between ON and OFF.

Parameters set as “OFF” are not 
displayed on the setting screen on the 
right side.

Parameters set as “OFF” are displayed 
in boldface type.
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Switching between display ON and OFF
1  Right-click the parameter to be or not to be displayed on the parameter tree screen (on the left side) of the “PUM loader – 

PUM Parameters Support” screen (on P.23), and click “Display ON/OFF.”

(2) Click.

(1) Right-click.

  You can also press the [F4] key on the keyboard while the parameter is selected on the parameter tree screen (on the left 
side) to switch between ON and OFF.

  You can also double-click the parameter on the parameter tree screen (on the left side) to switch between ON and OFF.

Point
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Relevant parameters

Detailed description of the selected parameters can be displayed. Detailed display/settings of related parameters can also be 
made.

1  Select a parameter from the parameter tree screen on the left side of the “PUM loader – PUM Parameters Support” screen 
(on P.23), and then right-click the setting that displays a related parameter on the setting screen (on the right side).

(1) Select a parameter from the tree. (2) Right-click the setting that displays a related parameter, or press 
the [F1] key on the keyboard.



34 INP-TN5A0201d-E

2  Check the related parameter on the “Relevant parameters” screen.

Displays related parameters. 
Setting change can also be 
made.

Click to display detailed manual of the parameter.

■To display detailed manual of the parameter
Click [Manual], and detailed manual of the parameter is displayed.
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Online function

As soon as the parameter is changed, the change can be written into the module-type temperature controller.

1  Select “Initial setting” on the “File” menu of the “PUM loader – PUMP Parameters Support” screen (on P.23).

Click.

2  Select “Online” on the “Initial setting” screen, and then click [OK].

(2) Click.

(1) Select Online.
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Note

  The “Online/Offl ine” setting can be made only when startup is performed by selecting “Module data reception launch mode” 
in “Startup mode” (P.17).

  If a parameter that affects other parameters is changed online, all the parameters of the module-type temperature controller 
having the changed parameter are read. Reading takes approximately 20 seconds per module-type temperature controller.

  If a parameter that changes its value when processing is exited such as auto tuning start command, reading is continued 
until the value reaches “0.”

  If “Offl ine” is selected in initial setting, do not set values for the following parameters other than those shown.
“Auto - tuning RUN command” = Stop/End
“Digital output latch release command” = OFF
“Reset main unit” = None

  The setting is always "Offl ine" on start-up.
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Module composition

The composition of the connected module-type temperature controllers can be checked.

1  Select “Module composition” from the “Tool” menu of the “PUMP loader – PUM Parameters Support” screen (on P.23).

Click.

2  Check the composition of the module-type temperature controller on the “Module composition” screen.

[Display screen of the control/event/analog module on start-up]

Displays model code/serial code. Displays the module-type temperature 
controller connected.

Displays Staion No.
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[Display screen of the enhanced communication module on start-up]

It displays model code/serial code. It displays the connected module-type 
temperature controller.

It displays St. No. for enhanced 
communication. (*Note that this is 
different from the St. No. of the loader 
communication port)

Note

Error is displayed if the module-type temperature controller is not connected properly.

[Error display]
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Checking the type code

The type code of the module-type temperature controller currently edited can be checked.

1  Select “Model composition” from the “Tool” menu of the “PUM loader – PUM Parameters Support” screen.

Click.

2  Select a desired model code on the “Display model code” screen, and then click [OK].

[Display screen of the control/event/analog module on start-up]

Click.
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[Display screen of the enhanced communication module on start-up]

 

Click.
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Displaying trend

Data trend can be displayed. Pens can be defi ned for up to 10 groups, with 8 pens regarded as one group.
• This method is not available when selected the "Enhanced comm module [Mitsubishi's programless comm]", "Enhanced comm 
module [Profi bus comm]" on the “module type selection”.

1  Select “Trend defi nition” from the “Tool” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Set required items on the “Trend selection” screen, and then click “Trend Disp.”

(2) Set the duration from the time when 
sampling is completed until the next 
sampling is started.

(1) Select a desired group.

(3) Set the values for which trend data 
is to be displayed. 
*1

(4) Starts collecting the 
trend data.

(6) Stops collecting the 
trend data.

(5) Click.

(7) Displays the trend data in 
CSV format.

*1: When you select the St. No from the analog module, do not select "Set value (SV)", "Manipulating value (MV1)", or 
"Manipulating value (MV2)".  
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3  Check the trend display on the “TrendDisplay – Trend” screen.

Select a pen for which scale is to be displayed.

Note

  Save the trend data, if required, in a CSV fi le by giving a name to it.
  If the trend data is displayed in a CSV fi le, the CSV fi le previously displayed is overwritten.
  If the displayed CSV fi le is saved, the time display becomes “00” (fraction omitted).
  If sec. display is required, select “time” for display format in Excel cell format setting, change it into desired display format, 
and then save the data.

  The fi rst data at the start of trend display may differ from the actual value.
  Do not press the “Start trend” button on the trend select screen while the trend is being displayed. Otherwise the trend is 
displayed overlapped.

  The fi nal data may not be displayed when the trend display is stopped. Check the data in CSV format in this case.
  When you select the St. No from the analog module, do not select "Set value (SV)", "Manipulating value (MV1)", or 
"Manipulating value (MV2)".
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Copying parameters

Parameter settings can be copied between channels or stations.
• This method is not available when selected the "Enhanced comm module [Mitsubishi's programless comm]", "Enhanced comm 
module [Profi bus comm]" on the “module type selection”.

Copying between channels

1  Select “Parameter copy” from the “Tool” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Click the “Ch. Copy” tab on the “Parameter copy” screen.

Click.
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3  Select the St-Ch No. from which the parameter is to be copied and that to which it is written, and then click [OK].

(1) Select the station No. and the channel No. of the fi le to be 
copied in “From (St.-Ch. No.)”

(3) Click.

(2) Select the channel No. to which the copied file is to be 
written in “To (Ch. No.)”

4  Click [OK] on the “PUM loader” window.

Click.

■To cancel parameter copying
  Click [Cancel].

In Ch. copy, the data is copied only within the station specifi ed in “From (St.-Ch. No.)”.

Note

  Make sure that the channel No. on the left side becomes smaller than that of the right side when specifying the channel to 
which the parameter is to be written.

  Copied parameters are not written into the module-type temperature controller online.
  When “Ch. copy” in parameter copy function is used, do not specify the No. of the station that does not exist. Otherwise an 
erroneous value is copied.

Point
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Copying between stations
1  Select “Parameter copy (C)” from the “Tool (T)” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Click the “St. copy” tab on the “Parameter copy” screen.

Click.

■To copy event module parameters between stations
  Click the “St. copy (Event)” tab.
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3  Select the St-Ch No. from which the parameter is to be copied and that to which it is written, and then click [OK].

(1) Select the station No. from which the parameter is to be 
copied in “From (St. No.)”.

(3) Click.

(2) Select the station No. to which the parameter is to be 
written in “To (St. No.)”.

4  Click [OK] on the “PUM loader” screen.

Click.

■To cancel the parameter copy
  Click [Cancel].

Follow the same procedure for copying parameters between stations (Event).

Note

  Be sure not to specify station No. that has not been defi ned. Otherwise an erroneous value may be written in the parameter.
  Make sure that the station No. of the left side becomes smaller than that of the right side when specifying the station to 
which the parameter is to be written.

  Copied parameters are not written into the module-type temperature controller online.
  You cannot inter-station copy on the other type modules.

Point
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Parameter list

Parameter setting can be printed or displayed in CSV fi le format for each module-type temperature controller.

1  Select “Parameter list” from the “Tool” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Set necessary items on the “Parameter list” screen, and then click “Print” or “CSV Disp.”

Select a module-type temperature controller to be printed or 
displayed.
*Note 1

Click to display the parameter list in 
CSV fi le format.

Click to print the parameter list.

Enter comment.

* Note1: The module type is not selectable when starting up with the enhanced communication module.
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Note

  The entered contents may be automatically converted into Excel format depending on the contents of the user comment. 
(Example: 4-20 → April 20)

  The value “0” in fractional portion is not displayed in CSV format.
  Printing is made on A4 paper in vertical orientation (fi xed).
  The setting display of the PUM parameter loader and the display of the printing/CSV output result may not be the same.
Example: If the PUM parameter loader display = “0009,” the result of printing/CSV output = “9.”

  If setting displayed in binary digit is printed or output in CSV format, the setting is displayed as a decimal number.
Example: If DO1 optional function setting = “0101,” the result of printing/CSV output = “101.”
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Uploading (Transmission from PUM to PC)

The parameter setting of the module-type temperature controller can be received in batch.

1  Select “Upload (PC ← PUM data transmit) (U)” from the “Data (D)” menu of the “PUM loader – PUM Parameters Support” 
screen (on P.23).

Click.

* Proceed to 2  when selected the “control/event/analog” on the “module type selection”.
*  Proceed to 3  when selected the "Enhanced comm module [Mitsubishi's programless comm]", "Enhanced comm module 

[Profibus comm]" on the “module type selection”.
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2  Check the ST Nos. of the module-type temperature controllers to be uploaded on the “Station defi nition” screen, and then 
click [OK].

(1) Check.

(2) Click.

Proceed to 4 .

Note

Do not check the box of the module not connected.

3  Click [OK] on the “PUM loader” screen.

Click.

■To cancel uploading
  Click [Cancel] .
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4  Click [OK] on the “PUM loader” screen.

Click [OK] to save the parameter setting currently selected.

Click.

■Not to save the parameter setting currently selected
  Click [Cancel] .

5  Select the fi le to which the parameter setting is to be saved on the “Save as” screen, and then click “Save.”

(1) Select the fi le in which the parameter 
setting is to be saved.

(2) Click.

Note

  Approximately 20 seconds are required for uploading per module-type temperature controller. Do not perform other 
communication operations while the settings are read.

  Do not turn off the power of the module-type temperature controller while the settings are read.
  Do not pull out the loader connection cable while the settings are read.
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 Downloading (Transmission from PC to PUM)

Parameter settings can be transmitted to the connected module-type temperature controllers.

1  Select “Download (PC → PUM data transmit (D)” from the “Data (D)” menu of the “PUM loader – PUM Parameters Support” 
screen (on P.23).

Click.

* Proceed to 2  when selected the “control/event/analog” on the “module type selection”.
*  Proceed to 3  when selected the "Enhanced comm module [Mitsubishi's programless comm]", "Enhanced comm module 

[Profibus comm]" on the “module type selection”.
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2  Check the St Nos. of the module-type temperature controllers to be downloaded on the “Station defi nition” screen, and then 
click [OK].

(1) Check.

(2) Click.

Note

Do not check the box of the module not connected.

■To cancel downloading.
  Click [Cancel] .

3  Click [OK] on the “PUM loader” screen.

Click.

■To cancel downloading.
  Click [Cancel] .
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Note

  Approximately 20 seconds are required for downloading per module-type temperature controller. Do not perform other 
communication operations while downloading.

  Do not turn off the power of the module-type temperature controller while downloading.
  Do not pull out the loader connection cable while downloading.
  Do not carry out downloading with the auto tuning start command set at “1.”
  Check that the main unit reset is set to “0,” communication permit setting to “1,” and that the master/slave data is correct, 
and then carry out downloading.
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Opening fi les

Data saved in a fi le can be read.

1  Select “Open” from the “Data” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Click [OK] on the “PUM loader” screen.

Click [OK] to save the parameter setting currently selected and go to 3.

Click.

■Not to save the parameter setting currently selected and go to 4.
  Click [Cancel].
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3  Select a fi le to which the parameter setting is to be saved on the “Save as” screen, and then click [Save (S)].

(1) Select the fi le in which the data is 
saved.

(2) Click.

4  Select the desired fi le on the “Open” screen, and then click [Open].

(2) Click.

(1) Select the parameter setting fi le.
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Saving the setting in a fi le

The current parameter settings can be saved in a fi le.

1  Select “Save” from the “Data” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Select the fi le in which the parameter settings are to be saved on the “Save as” screen, and then click [Save].

(1) Select the fi le.

(2) Click.
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Exiting the PUM parameter loader

Exit the PUM parameter loader as follows.

1  Select “Exit” from the “File” menu of the “PUM loader – PUM Parameters Support” screen (on P.23).

Click.

2  Click [Yes] on the “Exit” window.

Click [Yes] to save the parameter setting currently selected and go to 3.

Click.

■Not to save the parameter setting currently selected
  Click [No].

■To cancel the exit from PUM parameter loader
  Click [Cancel].
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3  Select a fi le in which the data is to be saved on the “Save as” screen, and then click [Save].”

(1) Select the fi le in which the data is to be 
saved.

(2) Click.
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9  Troubleshooting
The following table lists the trouble symptoms that may appear when the setting of the module-type temperature controller is 
made using the PUM parameter loader, their causes, and remedies.

Trouble Causes Solution

None of the connected module is 
capable of communicating with 
the loader software.

Improper PUM parameter loader software 
connection

Check that the PUM parameter loader software and 
the modules are connected properly.

Improper connection of the PUM 
parameter loader connecting cables

Check the connection of the PUM parameter loader 
connecting cable. Check if the cable is break or not.

Check if the assembly of the PUM parameter loader 
connecting cable is proper or not.

Improper station No. setting Check if communicating to the correct station 
number.

Check if the set station number is duplicated.

Incompatible communication conditions Check that the communication specifi cations of 
the loader software and those of the module are 
compatible.

Several master are defi ned. Defi ne only one master.

Only some of the connected 
modules cannot communicate 
with the PUM parameter loader.

Improper PUM parameter loader software 
connection

Check that the loader software is connected to the 
master of internal communication between modules.

Parameters can not be changed. RS-485 communication permission is set 
to "Read only".

Change the setting to "Readable/Writable".

The parameter input value tried to write 
the value out of the setting range

Change the parameter input value to the one in the 
setting range and then write again.

Parameter setting that has not  
been changed is changed.

SV value may be changed as a result of 
changing the SV value.

Set the SV limit value larger than the SV value. Set 
the SV value within the SV limit value range.

The parameter set value for industrial 
value display is automatically changed by 
change of PV input type, PV scale (Analog 
input type, Analog input scale for Analog 
module), decimal point position, unit 
display.

—

Alarm settings are automatically changed 
depending on the setting of DO output 
event type.

—

After download, parameter value 
was displayed as "-".

When selected an enhanced 
communication module, the value to the 
register address was set, which can not 
be accepted by a module. 

Upload (or restart the loader), and restore from 
the "-" state, and then set the appropriate register 
address.

Parameters are displayed as "–" 
after uploading/downloading.

Communication error may be occurring. Check the communication environment. Check the 
master/slave setting in connected modules.

Online mode cannot be used. Online mode cannot be used if startup 
is carried out by clicking "File selection 
startup mode".

Start from "Startup mode/Module data reception 
launch mode".
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Trouble Causes Solution

Data display is not updated when 
parameters are copied.

The tree display is not updated. Click the parameters on the parameter tree display 
(on the left side of the screen) to update the tree.

"Communication port does not 
open" is displayed.

Multiple communication programs have 
been started.

Terminate the all communication program, and then 
restart the PUM parameter loader.
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10 Table of corresponding revision No. to PUM parameter loader
This parameter loader corresponds to the revision numbers of PUM series listed in the table below..

Parameter
loader
version

Revision No. Languages

Control 
module

Event 
module

Analog 
module

Enhanced comm 
module

[Mitsubishi's 
PLC programless 

comm]

Enhanced comm 
module

[PROFIBUS]

Japanese English Chinese
*3

1.1.1 ○ ○ × × × ○ ○ ×

1.3.2 ○ ○ ○ 01A  *1 × ○ ○ ×

1.3.5 ○ ○ ○ 02A  *2 ○ ○ ○ ○

[Legend symbols]
○‥‥‥‥‥‥‥‥‥‥‥‥‥‥ Operate on the corresponding parameter version.
×‥‥‥‥‥‥‥‥‥‥‥‥‥‥ Unsupported. Use the parameter version marked ○ .
Character string,such as "01A" ‥  Operable parameter loader version differs depending on the revision No. of PUM series.

Check the revision No. with the following procedures, and use the corresponding parameter 
loader version.

    Find the revision No. of PUM series described on the seal by removing the front terminal block.
    Ex : In the case of a control module, the seal shown as below is applied.

*1: Use the version before 1.3.2.
*2: Use the version after 1.3.5.
*3: Operation on other than the Chinese-language version of Windows results in garble.

PUM - A

After " / " indicates the revision No.

No.

********T

NOTE : 

****/02A
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